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Firefox	adblock	disable.	Firefox	adblock	addon.

Avoid	support	scams.	We	will	never	ask	you	to	call	or	text	a	phone	number	or	share	personal	information.	Please	report	suspicious	activity	using	the	“Report	Abuse”	option.	Learn	More	This	thread	was	archived.	Please	ask	a	new	question	if	you	need	help.	I	had	adblocker,	it	poofed.	Now	I	cannot	download	it	at	all.	It	downloaded	on	Internet	explorer
ok.	I	had	adblocker,	it	poofed.	Now	I	cannot	download	it	at	all.	It	downloaded	on	Internet	explorer	ok.	If	you	haven't	already	shut	down	and	restarted	Windows,	you	might	try	that	in	case	this	is	a	file	permissions	problem	that	sometimes	occurs	after	Windows	updates.	It's	possible	that	an	extensions-related	settings	file	has	become	corrupted.	You	could
try	this:	Open	your	current	Firefox	settings	(AKA	Firefox	profile)	folder	using	either	"3-bar"	menu	button	>	"?"	button	>	Troubleshooting	Information	(menu	bar)	Help	>	Troubleshooting	Information	type	or	paste	about:support	in	the	address	bar	and	press	Enter	In	the	first	table	on	the	page,	click	the	"Show	Folder"	button.	This	should	launch	a	new
window	listing	various	files	and	folders	in	Windows	Explorer.	Leaving	that	window	open,	switch	back	to	Firefox	and	Exit,	either:	"3-bar"	menu	button	>	"power"	button	(menu	bar)	File	>	Exit	Pause	while	Firefox	finishes	its	cleanup,	then	rename	any	of	these	files	that	you	find:	compatibility.ini	to	something	like	compatibility-old.ini	extensions.ini	to
something	like	extensions-old.ini	extensions.json	to	something	like	extensions-old.json	extensions.sqlite	to	something	like	extensions-old.sqlite	(might	not	exist	depending	on	how	long	you've	been	using	this	settings	folder)	When	you	start	Firefox	back	up	again,	it	should	explore	your	profile	folder,	other	folders,	and	the	Windows	registry	to	rebuild	the
list.	It	probably	will	ask	you	to	approve	some	of	the	extensions.	Once	things	settle	down,	could	you	check	the	Add-ons	page	to	see	what	came	back?	Read	this	answer	in	context		1	There	are	a	lot	of	ad	blocking	add-ons.	Which	one	are	you	having	trouble	with?	If	you	need	a	new	one,	these	are	popular	(Note:	just	one	at	a	time	or	they	might	fight):	There
are	a	lot	of	ad	blocking	add-ons.	Which	one	are	you	having	trouble	with?	If	you	need	a	new	one,	these	are	popular	(Note:	just	one	at	a	time	or	they	might	fight):	*	*	Firefox	will	not	let	me	install	either	blocker	that	you	sent	me.	I	cannot	get	my	adblocker	plus	back.	it	starts	to	install	and	then	stops	installing!	Firefox	will	not	let	me	install	either	blocker
that	you	sent	me.	I	cannot	get	my	adblocker	plus	back.	it	starts	to	install	and	then	stops	installing!	evelyn40475	said	Firefox	will	not	let	me	install	either	blocker	that	you	sent	me.	Do	you	get	a	specific	error	message?	It	just	stops?	Have	you	had	any	other	issues	on	your	Firefox	that	might	be	related,	for	example,	problems	accessing	secure	sites?
''evelyn40475	[[#answer-903692|said]]''	Firefox	will	not	let	me	install	either	blocker	that	you	sent	me.	Do	you	get	a	specific	error	message?	It	just	stops?	Have	you	had	any	other	issues	on	your	Firefox	that	might	be	related,	for	example,	problems	accessing	secure	sites?	No.	I	signed	in	today	and	Adblock	Plus	was	gone.	I	tried	to	reinstall	it	and	it	just
strts	to	install	and	stops,	no	message.	The	other	blocker	you	sent	does	the	same	thing.	No.	I	signed	in	today	and	Adblock	Plus	was	gone.	I	tried	to	reinstall	it	and	it	just	strts	to	install	and	stops,	no	message.	The	other	blocker	you	sent	does	the	same	thing.	If	you	haven't	already	shut	down	and	restarted	Windows,	you	might	try	that	in	case	this	is	a	file
permissions	problem	that	sometimes	occurs	after	Windows	updates.	It's	possible	that	an	extensions-related	settings	file	has	become	corrupted.	You	could	try	this:	Open	your	current	Firefox	settings	(AKA	Firefox	profile)	folder	using	either	"3-bar"	menu	button	>	"?"	button	>	Troubleshooting	Information	(menu	bar)	Help	>	Troubleshooting	Information
type	or	paste	about:support	in	the	address	bar	and	press	Enter	In	the	first	table	on	the	page,	click	the	"Show	Folder"	button.	This	should	launch	a	new	window	listing	various	files	and	folders	in	Windows	Explorer.	Leaving	that	window	open,	switch	back	to	Firefox	and	Exit,	either:	"3-bar"	menu	button	>	"power"	button	(menu	bar)	File	>	Exit	Pause
while	Firefox	finishes	its	cleanup,	then	rename	any	of	these	files	that	you	find:	compatibility.ini	to	something	like	compatibility-old.ini	extensions.ini	to	something	like	extensions-old.ini	extensions.json	to	something	like	extensions-old.json	extensions.sqlite	to	something	like	extensions-old.sqlite	(might	not	exist	depending	on	how	long	you've	been	using
this	settings	folder)	When	you	start	Firefox	back	up	again,	it	should	explore	your	profile	folder,	other	folders,	and	the	Windows	registry	to	rebuild	the	list.	It	probably	will	ask	you	to	approve	some	of	the	extensions.	Once	things	settle	down,	could	you	check	the	Add-ons	page	to	see	what	came	back?	If	you	haven't	already	shut	down	and	restarted
Windows,	you	might	try	that	in	case	this	is	a	file	permissions	problem	that	sometimes	occurs	after	Windows	updates.	It's	possible	that	an	extensions-related	settings	file	has	become	corrupted.	You	could	try	this:	Open	your	current	Firefox	settings	(AKA	Firefox	profile)	folder	using	either	*	"3-bar"	menu	button	>	"?"	button	>	Troubleshooting
Information	*	(menu	bar)	Help	>	Troubleshooting	Information	*	type	or	paste	about:support	in	the	address	bar	and	press	Enter	In	the	first	table	on	the	page,	click	the	"Show	Folder"	button.	This	should	launch	a	new	window	listing	various	files	and	folders	in	Windows	Explorer.	Leaving	that	window	open,	switch	back	to	Firefox	and	Exit,	either:	*	"3-
bar"	menu	button	>	"power"	button	*	(menu	bar)	File	>	Exit	Pause	while	Firefox	finishes	its	cleanup,	then	rename	any	of	these	files	that	you	find:	*	'''compatibility.ini'''	to	something	like	compatibility-old.ini	*	'''extensions.ini'''	to	something	like	extensions-old.ini	*	'''extensions.json'''	to	something	like	extensions-old.json	*	'''extensions.sqlite'''	to
something	like	extensions-old.sqlite	(might	not	exist	depending	on	how	long	you've	been	using	this	settings	folder)	When	you	start	Firefox	back	up	again,	it	should	explore	your	profile	folder,	other	folders,	and	the	Windows	registry	to	rebuild	the	list.	It	probably	will	ask	you	to	approve	some	of	the	extensions.	Once	things	settle	down,	could	you	check
the	Add-ons	page	to	see	what	came	back?	Avoid	support	scams.	We	will	never	ask	you	to	call	or	text	a	phone	number	or	share	personal	information.	Please	report	suspicious	activity	using	the	“Report	Abuse”	option.	Learn	More	This	thread	was	archived.	Please	ask	a	new	question	if	you	need	help.	I'm	on	Win10	With	Firefox	83.0.	I	cleared	my	history
yesterday,	and	now	when	I	try	to	watch	video	on	CBS.com,	I	get	this	message:	“This	video	is	unavailable	because	we	were	unable	to	load	a	message	from	our	sponsors.	If	you	are	using	ad-blocking	software,	please	disable	it	and	reload	the	page.	Error	Code:	111”.	I	have	no	ad-blocking	software	that	I	know	of.	Can	anyone	give	me	a	clue	on	what	to	do?
I'm	on	Win10	With	Firefox	83.0.	I	cleared	my	history	yesterday,	and	now	when	I	try	to	watch	video	on	CBS.com,	I	get	this	message:	“This	video	is	unavailable	because	we	were	unable	to	load	a	message	from	our	sponsors.	If	you	are	using	ad-blocking	software,	please	disable	it	and	reload	the	page.	Error	Code:	111”.	I	have	no	ad-blocking	software	that
I	know	of.	Can	anyone	give	me	a	clue	on	what	to	do?	Try	turning	Enhanced	tracking	protection	off.	That	prevents	known	tackers	(frequently	comes	with	ads)	to	load.	That's	not	a	good	practice	for	privacy,	if	you	still	want	to	view	that	site,	go	ahead.	Read	this	answer	in	context		1	Try	turning	Enhanced	tracking	protection	off.	That	prevents	known
tackers	(frequently	comes	with	ads)	to	load.	That's	not	a	good	practice	for	privacy,	if	you	still	want	to	view	that	site,	go	ahead.	Try	turning	Enhanced	tracking	protection	off.	That	prevents	known	tackers	(frequently	comes	with	ads)	to	load.	That's	not	a	good	practice	for	privacy,	if	you	still	want	to	view	that	site,	go	ahead.	That	did	the	trick.	Thank	you
so	much	for	your	time.	Have	a	super	week.	That	did	the	trick.	Thank	you	so	much	for	your	time.	Have	a	super	week.	I'm	trying	to	watch	a	tv	programme	on	UK	Channel	4	Catch-up	and	am	prevented	until	I	turn	off	ad	blocking.	I	tried	turning	off	Enhanced	Tracking	Protection	and	it	made	no	difference.	I	just	want	to	whitelist	Channel	4's	URL	to
unblock	for	this	site	only.	Can't	find	how	do	I	do	it	-	I've	been	struggling	unsuccessfully	for	2	days	with	this.	I'm	trying	to	watch	a	tv	programme	on	UK	Channel	4	Catch-up	and	am	prevented	until	I	turn	off	ad	blocking.	I	tried	turning	off	Enhanced	Tracking	Protection	and	it	made	no	difference.	I	just	want	to	whitelist	Channel	4's	URL	to	unblock	for	this
site	only.	Can't	find	how	do	I	do	it	-	I've	been	struggling	unsuccessfully	for	2	days	with	this.	There	is	a	manager	exceptions	option	in	protection	settings.	There	is	a	manager	exceptions	option	in	protection	settings.	Avoid	support	scams.	We	will	never	ask	you	to	call	or	text	a	phone	number	or	share	personal	information.	Please	report	suspicious	activity
using	the	“Report	Abuse”	option.	Learn	More	This	thread	was	archived.	Please	ask	a	new	question	if	you	need	help.	Firefox	Browser	uprated	to	92.0	today.	Previously	whilst	browsing	Ad's	were	showing;	today	I	have	no	Ad's	displayed	but	have	not	enabled	an	Ad	Blocker	on	Firefox.	A	site	I	use	extensively	cannot	now	be	properly	viewed;	I	get	a
message	to	turn	off	Ad	Blocker.	I	have	set	Enhanced	Tracking	Protection	to	'Off'	but	am	still	unable	to	obtain	full	functionality,	I	am	using	standard	Firefox	Privacy	settings	otherwise.	I	am	able	to	browse	the	site	properly	using	MS	Edge.	I	have	deliberately	refrained	from	using	any	AD	Blocking	on	my	part	so	as	to	ensure	the	site	in	question	can	be
properly	viewed.	The	only	Firefox	extension	being	used	is	Kaspersky	Protection;	I	get	the	turn	off	Ad	Blocker	message	both	when	Kaspersky	Protection	is	on	or	off.	Firefox	Browser	uprated	to	92.0	today.	Previously	whilst	browsing	Ad's	were	showing;	today	I	have	no	Ad's	displayed	but	have	not	enabled	an	Ad	Blocker	on	Firefox.	A	site	I	use	extensively
cannot	now	be	properly	viewed;	I	get	a	message	to	turn	off	Ad	Blocker.	I	have	set	Enhanced	Tracking	Protection	to	'Off'	but	am	still	unable	to	obtain	full	functionality,	I	am	using	standard	Firefox	Privacy	settings	otherwise.	I	am	able	to	browse	the	site	properly	using	MS	Edge.	I	have	deliberately	refrained	from	using	any	AD	Blocking	on	my	part	so	as
to	ensure	the	site	in	question	can	be	properly	viewed.	The	only	Firefox	extension	being	used	is	Kaspersky	Protection;	I	get	the	turn	off	Ad	Blocker	message	both	when	Kaspersky	Protection	is	on	or	off.	If	the	ad	blocker	was	enabled	before	the	update,	it	should	still	be	enabled.	Load	the	web	page.	After	the	page	is	loaded,	click	the	AdBlock	icon.	Now
select	Disable	on	.	After,	reload	the	page.	If	the	ad	blocker	was	enabled	before	the	update,	it	should	still	be	enabled.	Load	the	web	page.	After	the	page	is	loaded,	click	the	AdBlock	icon.	Now	select	'''Disable	on	.'''	After,	reload	the	page.	Make	sure	you	are	not	blocking	content.	Diagnose	Firefox	issues	using	Troubleshoot(Safe)	Mode	{web	link}	A	small
dialog	should	appear.	Click	Start	In	Troubleshoot(Safe)	Mode	(not	Refresh).	Is	the	problem	still	there?	Many	site	issues	can	be	caused	by	corrupt	cookies	or	cache.	Warning	!	!	This	will	log	you	out	of	sites	you're	logged	in	to.	You	may	also	lose	any	settings	for	that	website.	How	to	clear	the	Firefox	cache	{web	link}	Make	sure	you	are	not	blocking
content.	[	.mozilla.org/en-US/kb/diagnose-firefox-issues-using-troubleshoot-mode	Diagnose	Firefox	issues	using	Troubleshoot(Safe)	Mode]	{web	link}	A	small	dialog	should	appear.	Click	'''Start	In	Troubleshoot(Safe)	Mode'''	(not	Refresh).	Is	the	problem	still	there?	---------------	.mozilla.org/en-US/kb/enhanced-tracking-protection-firefox-desktop	Many
site	issues	can	be	caused	by	corrupt	cookies	or	cache.	'''Warning	!	!	'''	This	will	log	you	out	of	sites	you're	logged	in	to.	You	may	also	lose	any	settings	for	that	website.	*	[	.mozilla.org/en-US/kb/delete-cookies-remove-info-websites-stored	Delete	cookies	to	remove	the	information	websites	have	stored	on	your	computer]	{web	link}	*	[	.mozilla.org/en-
US/kb/how-clear-firefox-cache	How	to	clear	the	Firefox	cache]	{web	link}	Hi	Fred	Thanks	for	your	response.	I	have	tried	each	of	the	steps	suggested	but	without	success.	I	also	tried	a	refresh	of	Firefox	and	a	renaming	of	the	Prefs	Java	file	within	my	profile	just	in	case.	The	bottom	line	is	that	even	without	an	Ad	Blocker	I	am	not	seeing	any	Ad's	when
using	Firefox.	As	such	my	access	to	the	site	mentioned	earlier	is	restricted.	Do	you	have	any	other	suggestions.	Do	you	think	deleting	Firefox	and	reinstalling	might	help??	Best	regards	Eric	Hi	Fred	Thanks	for	your	response.	I	have	tried	each	of	the	steps	suggested	but	without	success.	I	also	tried	a	refresh	of	Firefox	and	a	renaming	of	the	Prefs	Java
file	within	my	profile	just	in	case.	The	bottom	line	is	that	even	without	an	Ad	Blocker	I	am	not	seeing	any	Ad's	when	using	Firefox.	As	such	my	access	to	the	site	mentioned	earlier	is	restricted.	Do	you	have	any	other	suggestions.	Do	you	think	deleting	Firefox	and	reinstalling	might	help??	Best	regards	Eric	Start	your	Computer	in	safe	mode	with
network	support.	Then	start	Firefox.	Try	Secure	websites.	Is	the	problem	still	there?	Starting	Any	Computer	In	Safe	Mode	(web	link)	Free	Online	Encyclopedia	+++++++++++++++++++++++++++++++++++++++++++++++	If	the	problem	goes	away	with	the	computer	in	Safe	Mode,	the	problem	is	with	one	of	the	other	programs	on	the
system.	As	a	test,	disable	your	protection	programs.	Start	your	'''Computer'''	in	safe	mode	with	network	support.	Then	start	Firefox.	Try	'''Secure'''	websites.	Is	the	problem	still	there?	[	.thefreedictionary.com/Linux+Safe+Mode	Starting	Any	Computer	In	Safe	Mode]	(web	link)	Free	Online	Encyclopedia
+++++++++++++++++++++++++++++++++++++++++++++++	If	the	problem	goes	away	with	the	computer	in	Safe	Mode,	the	problem	is	with	one	of	the	other	programs	on	the	system.	As	a	test,	disable	your	protection	programs.	The	problem	persists	whilst	the	computer	is	in	safe	mode.	I	would	also	advise	that	as	a	test	I	downloaded
Firefox	to	my	wife's	computer;	the	same	no	Ad's	problem	occured.	To	complete	the	picture	I	have	also	tried	Firefox	with	my	Kaspersky	Internet	Security	disabled,	I	have	also	reset	KIS	settings	to	their	default	yet	the	issue	continues.	The	problem	persists	whilst	the	computer	is	in	safe	mode.	I	would	also	advise	that	as	a	test	I	downloaded	Firefox	to	my
wife's	computer;	the	same	no	Ad's	problem	occured.	To	complete	the	picture	I	have	also	tried	Firefox	with	my	Kaspersky	Internet	Security	disabled,	I	have	also	reset	KIS	settings	to	their	default	yet	the	issue	continues.	I	called	for	more	help.	Can	you	post	a	link	to	a	publicly	accessible	page	(i.e.	no	authentication	or	signing	on	required)?	You	can	check
the	Web	Console	(Tools	->	Web	Developer)	for	messages	about	blocked	content	and	about	the	presence	of	mixed	or	unsafe	content.	You	can	check	the	Network	Monitor	to	see	if	content	is	blocked	or	otherwise	fails	to	load.	If	necessary	use	"Ctrl+F5"	or	"Ctrl+Shift+R"	(Mac:	Command+Shift+R)	to	reload	the	page	and	bypass	the	cache	to	generate	a
fresh	log.	Can	you	post	a	link	to	a	publicly	accessible	page	(i.e.	no	authentication	or	signing	on	required)?	You	can	check	the	Web	Console	(Tools	->	Web	Developer)	for	messages	about	blocked	content	and	about	the	presence	of	mixed	or	unsafe	content.	*	You	can	check	the	Network	Monitor	to	see	if	content	is	blocked	or	otherwise	fails	to	load.	*	If
necessary	use	"Ctrl+F5"	or	"Ctrl+Shift+R"	(Mac:	Command+Shift+R)	to	reload	the	page	and	bypass	the	cache	to	generate	a	fresh	log.	Have	a	look	at	Ad's	ought	to	appear	on	the	right	hand	side	of	the	page	under	'Your	Skills	&	Rank'.	If	you	try	a	quiz	say	then	after	a	few	seconds	the	following	message	is	shown:-	Hello!	We	are	really	sorry	to	do	this
but	PurposeGames	uses	ads.	We,	like	many	others,	are	trying	to	keep	making	a	living	out	of	running	our	website.	It	would	help	us	a	lot	if	you	turned	off	any	ad	blocker	when	using	PurposeGames.	Again,	we	are	really	sorry	for	the	inconvenience	and	hope	you	will	understand!	Thank	you	for	your	continued	support!	The	PurposeGames	Team	I'm	sorry
but	Web	Console	etc	is	too	technical	for	me	Have	a	look	at	Ad's	ought	to	appear	on	the	right	hand	side	of	the	page	under	'Your	Skills	&	Rank'.	If	you	try	a	quiz	say	then	after	a	few	seconds	the	following	message	is	shown:-	Hello!	We	are	really	sorry	to	do	this	but	PurposeGames	uses	ads.	We,	like	many	others,	are	trying	to	keep	making	a	living	out	of
running	our	website.	It	would	help	us	a	lot	if	you	turned	off	any	ad	blocker	when	using	PurposeGames.	Again,	we	are	really	sorry	for	the	inconvenience	and	hope	you	will	understand!	Thank	you	for	your	continued	support!	The	PurposeGames	Team	I'm	sorry	but	Web	Console	etc	is	too	technical	for	me	Hello!	We	are	really	sorry	to	do	this	but
PurposeGames	uses	ads.	This	is	not	an	ad	per-sey,	it	is	part	of	the	webpage.	No	blocker	can	remove	this.	Hello!	We	are	really	sorry	to	do	this	but	PurposeGames	uses	ads.	This	is	not	an	ad	per-sey,	it	is	part	of	the	webpage.	No	blocker	can	remove	this.	I	think	we	are	at	cross	purposes	here.	With	Firefox	91	I	saw	commercial	Ad's	on	the	site	in	question,
they	were	displayed	as	mentioned	on	the	right	hand	side	of	the	page	under	'Your	Skills	&	Rank'.	When	I	played	quizzes	there	were	no	issues	or	messages.	With	Firefox	92	I	no	longer	see	Ad's	on	the	site	page;	if	I	try	a	quiz	I	get	the	message	'Hello!	We	are	really	sorry	to	do	this	but	PurposeGames	uses	ads....'	it	is	no	longer	possible	to	complete	quizzes.
I	have	not	changed	any	settings	in	Firefox;	there	is	clearly	something	in	the	upgrade	from	version	91	to	version	92	that	is	stopping	the	normal	Ads	being	displayed.	This	in	turn	leads	to	the	error	message	'Hello!	We	are	really	sorry	to	do	this	but	PurposeGames	uses	ads...'	Obviously	the	error	message	is	part	of	the	webpage	and	it	is	not	in	itself	an	Ad,	I
am	not	trying	to	remove	this.	I	have	the	same	issue	with	Firefox	92	on	my	wife's	laptop,	my	old	laptop	and	my	tablet,	with	each	I	get	the	site	error	message	because	normal	commercial	Ad's	are	no	longer	seen.	I	an	not	trying	to	block	any	Ad's	on	the	site;	I	don't	run	an	Ad	Blocker	but	there	is	something	within	Firefox	92	which	differs	from	Firfox	91
which	causes	ordinary	commercial	Ad's	to	be	blocked.	As	mentioned	I	have	no	issues	with	the	PurposeGames	site	using	MS	Edge;	I	simply	see	the	normal	Ads	I	used	to	see	with	Firefox	91	Do	you	see	normal	Ad's	on	PurposeGames	site	with	Firefox	92?	I	think	we	are	at	cross	purposes	here.	With	Firefox	91	I	saw	commercial	Ad's	on	the	site	in	question,
they	were	displayed	as	mentioned	on	the	right	hand	side	of	the	page	under	'Your	Skills	&	Rank'.	When	I	played	quizzes	there	were	no	issues	or	messages.	With	Firefox	92	I	no	longer	see	Ad's	on	the	site	page;	if	I	try	a	quiz	I	get	the	message	'Hello!	We	are	really	sorry	to	do	this	but	PurposeGames	uses	ads....'	it	is	no	longer	possible	to	complete	quizzes.
I	have	not	changed	any	settings	in	Firefox;	there	is	clearly	something	in	the	upgrade	from	version	91	to	version	92	that	is	stopping	the	normal	Ads	being	displayed.	This	in	turn	leads	to	the	error	message	'Hello!	We	are	really	sorry	to	do	this	but	PurposeGames	uses	ads...'	Obviously	the	error	message	is	part	of	the	webpage	and	it	is	not	in	itself	an	Ad,	I
am	not	trying	to	remove	this.	I	have	the	same	issue	with	Firefox	92	on	my	wife's	laptop,	my	old	laptop	and	my	tablet,	with	each	I	get	the	site	error	message	because	normal	commercial	Ad's	are	no	longer	seen.	I	an	not	trying	to	block	any	Ad's	on	the	site;	I	don't	run	an	Ad	Blocker	but	there	is	something	within	Firefox	92	which	differs	from	Firfox	91
which	causes	ordinary	commercial	Ad's	to	be	blocked.	As	mentioned	I	have	no	issues	with	the	PurposeGames	site	using	MS	Edge;	I	simply	see	the	normal	Ads	I	used	to	see	with	Firefox	91	Do	you	see	normal	Ad's	on	PurposeGames	site	with	Firefox	92?	This	seems	to	be	about	a	new	feature	in	Firefox	called	smartblock	that	replaces	some	tracking
scripts	with	a	limited	local	version.	If	I	disable	this	smartblock	feature	via	the	about:config	page	then	the	ads	appear	and	the	website	works.	It	would	be	nice	if	you	could	disable	this	feature	on	websites	that	aren't	working	properly	with	it	enabled.	See	also:	This	seems	to	be	about	a	new	feature	in	Firefox	called	smartblock	that	replaces	some	tracking
scripts	with	a	limited	local	version.	If	I	disable	this	smartblock	feature	via	the	about:config	page	then	the	ads	appear	and	the	website	works.	*	It	would	be	nice	if	you	could	disable	this	feature	on	websites	that	aren't	working	properly	with	it	enabled.	See	also:	*	Modified	September	11,	2021	at	1:25:52	PM	PDT	by	cor-el	Note	that	you	may	have	to	reload
and	bypass	the	cache	after	disabling	smartblock.	You	can	reload	webpage(s)	and	bypass	the	cache	to	refresh	possibly	outdated	or	corrupted	files.	hold	down	the	Shift	key	and	left-click	the	Reload	button	press	"Ctrl	+	F5"	or	press	"Ctrl	+	Shift	+	R"	(Windows,Linux)	press	"Command	+	Shift	+	R"	(Mac)	Note	that	you	may	have	to	reload	and	bypass	the
cache	after	disabling	smartblock.	You	can	reload	webpage(s)	and	bypass	the	cache	to	refresh	possibly	outdated	or	corrupted	files.	*hold	down	the	Shift	key	and	left-click	the	Reload	button	*press	"Ctrl	+	F5"	or	press	"Ctrl	+	Shift	+	R"	(Windows,Linux)	*press	"Command	+	Shift	+	R"	(Mac)	Thanks.	I	have	regained	the	Ad's	by	disabling	Smartblock.	The
site	in	question	now	works	as	it	used	to.	Thanks.	I	have	regained	the	Ad's	by	disabling	Smartblock.	The	site	in	question	now	works	as	it	used	to.	Clicking	the	"Shield	Icon"	Tracking	Protection	and	choosing	"Enhanced	Tracking	Protection"	OFF	solved	my	problem	of	unwanted	warning	to	"turn	off	Ad	Blocker"	even	though	an	Active	Intentional	Ad
Blocker	was	NOT	running!	Clicking	the	"Shield	Icon"	Tracking	Protection	and	choosing	"Enhanced	Tracking	Protection"	OFF	solved	the	issue.	However,	the	popup	might	erratically	reappear.	Simply	refresh	the	page	and	popup	disappears.	Hope	this	helps	alleviate	this	damnable	issue!!	Clicking	the	"Shield	Icon"	Tracking	Protection	and	choosing
"Enhanced	Tracking	Protection"	OFF	solved	my	problem	of	unwanted	warning	to	"turn	off	Ad	Blocker"	even	though	an	Active	Intentional	Ad	Blocker	was	NOT	running!	Clicking	the	"Shield	Icon"	Tracking	Protection	and	choosing	"Enhanced	Tracking	Protection"	OFF	solved	the	issue.	However,	the	popup	might	erratically	reappear.	Simply	refresh	the
page	and	popup	disappears.	Hope	this	helps	alleviate	this	damnable	issue!!	Stephen	Thanks	for	your	suggestion	Stephen	Thanks	for	your	suggestion
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